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Введение

О существовании атмосферного электрического поля известно давно. Уже
в 18 веке проводились исследования явлений атмосферного электричества таки-
ми учёными как Ломоносов, Рихтер, Делибар, Франклин, Лемонье. Тогда великие
умы в основном были сконцентрированы на изучении гроз и молний, поскольку
считалось, что образование поля происходит в период непогоды, что подразумева-
ет под собой грозовую облачность в качестве генераторов, поддерживающих по-
ле. Чуть позже, знаменитый британский физик Томсон Лорд Кельвин высказал
предположение о том, что в будущем предсказание погоды будет осуществлять-
ся посредством электрометра. Возможно, что, при пробуждении интереса учёных
к атмосферному электрическому полю, и при верности его слов, действительно
прогнозы погоды будут проще; т.к. на сегодняшний день, этот параметр не учи-
тывается, поэтому данная выпускная квалификационная работа, посвящённая ис-
следованию атмосферного электричества, является актуальной.

Спустя два столетия, несмотря на угасающий интерес к этой теме, была вы-
явлена ещё одна составляющая образования атмосферного электричества это га-
лактические космические лучи и солнечные космические лучи. [1] Это значит, что
атмосферное электрическое поле может происходить при хорошей погоде. Таким
образом, стала понятна связь электрического поля с интенсивностью галактиче-
ских космических лучей: после эффекта Форбуша напряжённость атмосферного
электрического поля падает, но через несколько дней возвращается к прежним
значениям. Так же, формирование электрического поля происходит благодаря
ионизации излучением естественных радиоактивных источников почвы, и возник-
новению зарядов за счёт фазовых переходов в воде.

Цель работы заключается в разработке регистрирующего устройства на-
пряжённости поля.

Для достижения поставленной цели необходимо решить следующие задачи:
провести обзор основных параметров атмосферного электрического поля и

методов их измерения;
разработать конструкцию флюксметра;
реализовать флюксметр в виде микропроцессорного устройства беспровод-

ной передачей данныз измерений;
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провести серию измерений напряжённости электрического поля;
осуществить анализ данных измерений, для выявления особенностей и вза-

имной зависимости электрических и атмосферных параметров погоды.
Выпускная квалификационная работа состоит из введения, четырех глав,

заключения, и списка используемых источников. В первой главе представлены
общие характеристики электрического поля атмосферы. Во второй описаны мето-
ды измерений напряжённости атмосферного электрического поля. В третьей рас-
сказывается о методах создания цифрового флюксметра, а так же особенности
конструкции устройста. В четвертой главе проанализированы данные, получен-
ные при помощи установки. В заключении подведены итоги проделаной работы,
выявлены её перспективы. Так же в конце, представлен список используемых ис-
точников.
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1 Элементы атмосферного электричества

1.1 Основные параметры электрического поля атмосферы

Основные параметры электрического поля атмосферы Уже достаточно дав-
но известно о существовании электрического поля в атмосфере Земли. Электри-
ческое поле атмосферы практически всегда вертикально, направлено вдоль Z-
компоненты от ионосферы к Земле - E. Говоря о годовом ходе атмосферного
электрического поля, то оно уменьшается летом и возрастает зимой. Так же из-
вестно, что электрическое поле атмосферы увеличивается в горах, но, в целом,
уменьшается с высотой. Электрическое поле обладает уникальной особенностью,
которую необходимо выделить среди других. Величина Е практически постоянна
для различных регионов Земли и в различное время года Е = - 130 В/м. Сезонные
изменения величины Е летом и днем, и т.п., только подчеркивают эту особенность
атмосферного электричества [1]. Любая модель атмосферного электричества вы-
зывает сомнение, коль скоро она не найдёт логичное объяснение этому факту.
Однако многолетние наблюдения за распределением гроз по поверхности Земли,
говорят совсем об обратном: количество гроз и их расположение на Земле, меня-
ется день ото дня, причём, иногда - на порядок.

В двадцатых годах прошлого века Симпсон, Маучли и Свердруп обнаружи-
ли так называемую унитарную вариацию, или «кривую Карнеги», атмосферного
электрического поля Е, то есть синхронные изменения напряженности поля вели-
чины Е, в целом по Земле. Ещё в 1920 году Вильсон высказал предположение,
что унитарная вариация Е вызвана грозами, которые приводят к заряжению Зем-
ли и высоких слоёв атмосферы, зарядами разных знаков. Эти идеи в будущем
развили Уиппл и Скрейз, которые предположили, что двухсуточный ход поля
подобен суточному ходу площади поверхности материков Земли, занятой гроза-
ми. Эта модель объяснения унитарной вариации атмосферного электрического
поля признана до сих пор. Принято считать, что все проявления атмосферного
электричества, такие как унитарная вариация, корреляции его с галактическими
космическими лучами (ГКЛ), о чём будет рассказано ниже, и метеоусловиями,
связаны с электрическим полем «хорошей погоды».
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1.2 Генерация электрического поля облаками

Опыты показывают, что вблизи земной поверхности есть достаточно силь-
ное электрическое поле, которое при отсутствии облаков направленно сверху вниз
(это «нормальное» поле) и имеет порядок 100 В/см. При этом возможны колеба-
ния около этого значения с амплитудой, которая не превышает десятков вольт
на метр. Несмотря на это, при наличии облачности, данные колебания могут до-
стигать больших значений (до 104 В/см) и приводить к изменению не только
величины поля, но даже и направлению на противоположное [1]. К примеру, про-
хождение облака над данной местностью, может сопровождаться, и как правило,
сопровождается уменьшением градиента потенциала, который в случае облаков
с большой вертикальной мощностью меняет знак, а это соответствует изменению
нормального направления поля на обратное (снизу вверх).

Все эти факты подтверждаются рядом других фактов, установленных Симп-
соном, и другими исследователями, при помощи специально сконструированного
ими прибора для записи величины и направления электрического поля в атмосфе-
ре (так называемый альтиэлектрограф) и характеризующих распределение поля
с высотой до 8 км, однако точность этого прибора оставляло желать лучшего.

Таким образом, в присутствии облаков, поле атмосферы искажается. При-
чём так, что под облаком оно ослабевает, и принимает обратное значение, внутри
же облака оно сохраняет нормальное направление (сверху вниз), при этом сред-
няя напряжённость его примерно в 100 раз больше, чем у поверхности земли при
ясном небе (то есть порядка 104 В/см), и над облаком поле имеет обратное нор-
мальному направление, и напряжённость меньше, чем внутри облака.

В отсутствие облаков, поверхность земли имеет отрицательный заряд, а
положительный заряд, который компенсирует отрицательный, находится в атмо-
сфере. Про происхождение этих зарядов и их связь с поляризацией до недавнего
времени было неизвестно, однако будет рассказано ниже.

Можно сказать, что электрическое поле атмосферы над земной поверхно-
стью сводится к результирующему полю облаков и имеет вид, изображённый на
рисунке 1.1. Под облаком аномальное движение за счёт заряженной положительно
поверхности земли, при этом площадь «аномальной» зоны чуть больше площади
самого облака. Вне пределов рассматриваемой зоны электрическое поле имеет
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нормальное направление. Его силовые линии берут начало на верхней кромке об-
лака с положительным зарядом. Сначала они направляются вверх или вбок, затем
облака заворачивают к земной поверхности, опускаясь в вертикальном направле-
нии.

Рисунок 1.1 — Поле облака и его отражения в поверхности земли

Рисунок 1.1 - Поле облака и его отражения в поверхности земли
Электрическое поле безоблачной атмосферы над поверхностью земли обу-

славливается тем же образом, что и внутри облаков, то есть электрической поля-
ризацией последних, благодаря влиянию земной поверхности, на которой имеются
заряды противоположного знака, однако явления в атмосфере Земли осложняют-
ся рядом других обстоятельств.
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1.3 Глобальная электрическая токовая цепь

Глобальная атмосферно-электрическая цепь определяет в атмосфере ба-
ланс электрических токов, условия поддержания электрического поля, а также
структуру электрических полей и токов. Многолетние данные измерений элек-
трических характеристик атмосферы вблизи поверхности земли прямо указыва-
ют на существование электрического поля напряженностью порядка 102 В/м и
электрического тока плотностью порядка 10-12 А/м2 [1]. Эти параметры опреде-
ляются в условиях так называемой хорошей погоды, то есть, при отсутствии в
данном районе Земли облаков, ветров, или метелей. Измерения электрического
поля «хорошей погоды» вблизи земной поверхности позволяют оценить некото-
рый эффективный заряд Земли, который составляет 105 К. Поскольку атмосфера
Земли обладает электропроводностью, то очевидно, что при отсутствии источни-
ков электрического поля, электрическое поле в атмосфере исчезает примерно за
10 мин. Согласно современным представлениям, основным источником электри-
ческого поля в тропосфере и стратосфере являются грозовые облака. Грозовые
облака выступают в роли токовых генераторов. Возможно, что грозовые облака
не единственные генераторы, поддерживающие электрическое поле атмосферы,
поскольку ещё не до конца выяснена роль генераторов, действующих в верхних
слоях атмосферы, облаков слоистых форм, конвективного токового генератора,
действующего в пограничном слое атмосферы. Отметим так же, что в областях
существования грозовых облаков текут токи, заряжающие атмосферу, в областях,
свободных от грозовых облаков, текут токи разрядки.

Основные уравнения, описывающие глобальную токовую цепь, имеют сле-
дующий вид [1]:

rot (E) = −µ0H
dt

, (1)

rot (H) = −j + E0E
dt

, (2)

div(E) = − ρ

E0
, (3)

div(H) = 0, (4)

8



dρ

dt
= 0, (5)

где Е - напряженность электрического поля, Н - напряженность магнитного
поля, ρ - плотность электрического заряда, j — плотность электрического тока,
E0 , µ0 - диэлектрическая и магнитная проницаемости вакуума.

В условиях, когда T » L (E0µ0), T » 2πµ0L2 (Т - характерный времен-
ной масштаб, L - характерный пространственный масштаб), система уравнений
сводится к следующей системе:

rot (E) = 0, (6)

div(E) = − ρ

E0
, (7)

(
dρ

dt

)
+ div(j) = 0. (8)

Важно отметить, эта система фактически описывает все электрические про-
цессы в нижних слоях атмосферы, исключая только быстропеременные процессы,
которые протекают при молниевых разрядах. Последнее уравнение для плотно-
сти электрического заряда есть следствие уравнения для rotH, если от него взять
операцию div. Выражение для плотности электрического тока записывается в сле-
дующем виде:

j = λ++dt+ dρ+ s, (9)

где v – гидродинамическая скорость движения среды, dt – коэффициент
турбулентной диффузии, js — плотность электрического тока, создаваемая i-м
источником. Последний член, входящий в выражение, описывает источники тока
в атмосфере, которыми являются грозы, в частности. Второй и третий члены
существенны в пограничном слое атмосферы.

Если выполнено условие Т » E0 / λ = tλ, то в этом случае током смещения
E0dE/dt можно пренебречь и тогда система уравнений превращается в стацио-
нарную:

div(j) = 0, (10)
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rot (E) = 0, (11)

div(E) =
ρ

E0
. (12)

При всём при этом, важную роль в исследовании электрических процессов
в атмосфере играет её электропроводящие свойства. Ионный состав атмосферы в
нижнем слое довольно-таки сложен. Имеется целый спектр ионов, которые пред-
ставляют собой комплексы молекул, которые несут заряд, равный элементарному
заряду (заряд электрона е). Атмосферные ионы различаются химической приро-
дой входящих в них молекул, коэффициентом диффузии, подвижностью. Можно
выделить примерно пять групп ионов в зависимости от их радиуса [1]:

лёгкие (малые) ионы (r < 6.6 · 10−10 м);
лёгкие промежуточные ионы (r < 810 · 10−10 м);
тяжёлые (большие) промежуточные ионы (r < 2.5 · 10−8 м);
ионы Ланжевена (r < 5.7 · 10−8 м);
ультра тяжёлые ионы (r > 5.7 · 10−9 м).
Согласно современным представлениям, основной вклад в электропровод-

ность нижних слоёв атмосферы вносят лёгкие ионы. Электропроводность в этой
части земной атмосферы формируется под влиянием радиоактивного излучения
поверхности Земли, радиоактивных примесей, содержащихся в воздухе, а так же
космического излучения. По мере удаления от земной поверхности она растёт и
её зависимость от высоты может быть представлена в виде:

λ = λ0expα [(r–r0)] , (13)

где r0 — радиус Земли; α−1 = 6400 м.
Кроме высотных изменений λ в атмосфере наблюдаются широтные измене-

ния, связанные с зависимостью интенсивности ГКЛ от широты, значения которой
на полюсе и экваторе различаются между собой в два раза.
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1.4 Связь напряжённости электрического поля с потенциалом солнечной
модуляции ГКЛ

Обратившись к справочным данным по величине коэффициента объемной
рекомбинации , обнаруживается, что величина α изменяется в пределах: 10−16 –
10−12 м3 c−1. Согласно данным, приведенным в [9] скорость рекомбинации поло-
жительных ионов с электронами α 10−12 м3 c−1 , при этом коэффициент рекомби-
нации между ионами меньше α 10−16 м3 c−1. Если предположить, что процесс ион
ионной рекомбинации превалирует над ион-электронной, то ГКЛ по-видимому, не
могут обеспечить необходимый приток зарядов.

Однако экспериментально установлено, что ионизация атмосферного воз-
духа космическими лучами q происходит в соответствии с линейным уравнением
ионного баланса: q =. Обычно используют квадратичное уравнение: q = N 2. Тут
αм3 – коэффициент объемной рекомбинации, β – коэффициент линейной реком-
бинации. Данные коэффициенты различаются по величине и по размерности. Эта
зависимость указывает на то, что в действительности связь между концентраци-
ей ионов в атмосфере и потоком космических лучей является более сильной, чем
это ранее предполагалось. ГКЛ оказывают решающее влияние на формирование
атмосферного электрического поля. Обратим внимание на рисунок 1.2, на кото-
ром видна корреляция между потоком ГКЛ и плотностью электрического тока
проводимости.

Рисунок 1.2 — Временной ход плотности атмосферного тока j и потока ГКЛ на
средних широтах [1]
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Стоит учесть, что уменьшение плотности потока ГКЛ и тока проводимости
j соответствуют периодам максимальной активности Солнца (69-70 и 80-82 гг.), а
их синхронное увеличение - минимальной (76-77 гг.).

Рисунок 1.3 — Отклонение от нормы потенциала солнечной модуляции О

Рисунок 1.4 — Напряжённость электрического поля атмосферы

Согласно данным солнечной модуляции космических лучей регистрируе-
мой наземными нейтронными мониторами и ионизационными камерами [14], пред-
ставленным на рисунках 1.3 и 1.4, так же видно, что вариации этих двух пара-
метров совпадают с течением времени, что подтверждает связь напряжённости
атмосферного электрического поля с потоком ГКЛ.

1.5 Связь напряжённости поля с интенсивностью осадков

Поскольку облачность оказывает влияние на напряжённость атмосферного
электрического поля, то смело можно предположить, что не только водяные капли
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в облаке определяют напряжённость. Имеет смысл сопоставить выпавшие осадки
с показаниями флюксметра. В ходе работы, была налажена связь с британским
университетом Ридинга, который предоставил данные флюксметра и осадков за
2009-2013 годы [13]. Прокоррелировав дынные, получаем прямую зависимость,
представленную на рисунках 1.5, 1.6.

Рисунок 1.5 — Корреляция за зимний период (r=0.98) с 2009 по 2013 годы на
абсерватории Ридинг (Великобритания)

Рисунок 1.6 — Корреляция за летний период (r=0.65) с 2009 по 2013 годы на
абсерватории Ридинг (Великобритания)
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Видно, что чем больше осадков выпадало, тем большие вариации напря-
жённости поля возникали.

Исходя из вышеперечисленного, можно заключить, что напряжённость элек-
трического поля является уникальным для метеорологии параметром, который
стоит учитывать при оценке погоды.
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2 Измерения атмосферного электрического поля

2.1 Метод разности потенциалов

Сей метод относится к группе методов, основанных на использовании со-
отношения: E = −dV/dh. Измеряются потенциалы V на разных высотах h.

2.2 Метод Пельтье

Используя метод Пельтье, понадобится проводник в виде шара, подвешен-
ный на высоте h, и соединенный с электрометром. На проводнике за счёт ин-
дукции происходит разделение и накопление зарядов Q. Зная ёмкость шара С, и
измерив Q, определяется потенциал V : Q = −СV .

2.3 Метод коллекторов

Данный метод состоит в автоматическом измерении потенциала электро-
метрами одновременно в нескольких местах. Коллектора при этом обычно ис-
пользуются: механические, распылительные, пламенные, радиоактивные. Так же,
характеризуются: ёмкостью, кажущимся сопротивлением, временем релаксации,
степенью изоляции и прочим.

2.4 Метод Вильсона

Этот метод базируется на использовании уравнения E = V/n = 4, где Е –
напряжённость электрического поля атмосферы, V – его потенциал, n – нормаль
поля, – поверхностная плотность заряда Земли. Для использования этого метода
разработана схема датчика, представленная на рисунке 2.1, где А – вращающий-
ся модулятор, Б – датчик, подключённый к электрометру, и изолированный от
корпуса флюксметра.

Принцип действия прибора не сложен. При вращении модулятора А, сен-
сорная пластина Б предстает то открытой для проникновения атмосферного элек-
трического поля, то закрытой. Причём, при открытом положении, на нижней ча-
сти пластины образуется положительный заряд с плотностью , а на остальной ча-
сти прибора распределяется отрицательный заряд. Таким образом, электрометр
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Рисунок 2.1 — Схема динамического флюксметра

даст отклонение, которое является относительной мерой плотности . А благодаря
уравнению E = 4 без особого труда можно сосчитать напряженность атмосферного
электрического поля Е. Благодаря вращающемуся модулятору, сигнал становится
пульсирующим, и его можно легко зарегистрировать.

Поскольку, это устройство относится к разряду электрических измерений,
то его можно использовать для измерения и регистрации напряженности элек-
трического поля атмосферы в широком динамическом диапазоне с повышенной
чувствительностью проводя метеорологические, геофизические, радиофизические
исследования, равно как и для оценки экологического состояния атмосферы и по-
верхности Земли.

Известно, что вертикальная составляющая напряженности электрического
поля атмосферы у поверхности Земли (Е) при условии хорошей погоды (отсут-
ствие гроз, каких-либо осадков, облачности и т.д.) составляет величину около
минус 130 В/м и может меняться в пределах нескольких (порой десятков) ки-
ловольт на метр по абсолютному значению, в зависимости от наличия тех или
иных атмосферных процессов или явлений [1]. При этом, наиболее интенсивные
спектральные компоненты вариации напряженности атмосферного электрическо-
го поля обнаруживаются среди частот от 0 до 0.06 Гц [2]. Однако некоторые
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геофизические процессы могут сопровождаться незначительными вариациями на-
пряженности электрического поля атмосферы с амплитудой порядка единиц и
долей милливольт на метр [3]. В связи с этим, получить информацию о вариа-
циях атмосферного электрического поля с малой амплитудой, особенно при на-
личии сильных источников электрического поля, к примеру, кучевой облачности,
атмосферного фронта и т.д., может быть затруднено по причине недостаточной
чувствительности или ширины динамического диапазона измерителя.

Подобные приборы производят многие фирмы, например Vaisala. Однако
его можно сделать и собственными руками. Для этого, в качестве электромет-
ра используем АЦП микроконтроллера Arduino Nano. Остальные части устрой-
ства создадим из подручных средств, согласно рисунку 1.1. В Arduino Nano за-
пишем программу (скетч), благодаря которой будет происходить считывание дан-
ных с сенсорной пластины устройства, подача электрического тока на вращаю-
щий двигатель, а так же передача данных через WiFi модуль ESP8266 на сервер
thingspeak.com [4]. Таким образом, при наличии вблизи динамического электро-
метра точки доступа в Интернет, можно получать данные дистанционно, или же
использовать в работе, например, переносной метеорологической станции.

Таким образом, для измерения напряжённости атмосферного электриче-
ского поля лучше всего пользоваться методом Вильсона, постольку поскольку, у
этого метода больше достоинств, чем недостатков, среди которых:

1) возможность создания микроконтроллерного устройства с доступным
интерфейсом;

2) наличие возможности непрерывных измерений;
3) компактная и малозатратная конструкция флюксметра.
Подводя итог, стоит отметить что существует множество методов регистра-

ции напряжённости, и лучшим является метод Вильсона, который и предстоит
реализовать с помощью микроконтроллера Arduino IDE.
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3 Цифровой флюксметр

3.1 Микроконтроллер Arduino Nano

Стоит начать с того, что Arduino — торговая марка аппаратно-программ-
ных средств для построения простых систем автоматики и робототехники, ориен-
тированная на непрофессиональных пользователей. Программная часть состоит
из бесплатной программной оболочки (Arduino IDE) для написания программ, их
компиляции и программирования аппаратуры. Аппаратная же часть представля-
ет собой набор смонтированных печатных плат, продающихся как официальным
производителем, так и сторонними производителями. Полностью открытая архи-
тектура системы позволяет свободно копировать или дополнять линейку продук-
ции Arduino. Так же, Arduino может использоваться как для создания автоном-
ных объектов автоматики, так и подключаться к программному обеспечению на
компьютере через стандартные проводные и беспроводные интерфейсы.

Под торговой маркой Arduino выпускается несколько плат с микроконтрол-
лером и платы расширения (так называемые шилды). Большинство плат с мик-
роконтроллером снабжены минимально необходимым набором обвязки для нор-
мальной работы микроконтроллера (стабилизатор питания, кварцевый резонатор,
цепочки сброса и т. п.).

Arduino и Arduino-совместимые платы спроектированы таким образом, что-
бы их можно было при необходимости расширять, добавляя в устройство новые
компоненты. Эти платы расширений (см. рисунок 3.1) подключаются к Arduino
посредством установленных на них штыревых разъёмов (см. рисунок 3.2). Суще-
ствует ряд плат с унифицированным конструктивом, допускающим конструктив-
но жесткое соединение процессорной платы и плат расширения в стопку через
штыревые линейки. Помимо этого, выпускаются платы уменьшенных габаритов
(например, Nano, Lilypad) и специальных конструктивов для задач робототехни-
ки. Независимыми производителями также выпускается большая гамма всевоз-
можных датчиков и исполнительных устройств, в той или иной степени совмести-
мых с базовым конструктивом Arduino [10].

В концепцию Arduino не входит корпусной или монтажный конструктив.
Разработчик выбирает метод установки и механической защиты плат самосто-
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Рисунок 3.1 — Микроконтроллер Arduino Nano

Рисунок 3.2 — Расширяющая плата для Arduino nano и Arduino UNO

ятельно. Сторонними производителями выпускаются наборы робототехнической
электромеханики, ориентированной на работу совместно с платами Arduino.

Микроконтроллеры для Arduino отличаются наличием предварительно про-
шитого в них загрузчика (bootloader). С помощью этого загрузчика пользователь
загружает свою программу в микроконтроллер без использования традиционных
отдельных аппаратных программаторов. Загрузчик соединяется с компьютером
через интерфейс USB (если он есть на плате) или с помощью отдельного переход-
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ника UART-USB. Поддержка загрузчика встроена в Arduino IDE и выполняется
нажатием на одну клавишу.

На случай затирания загрузчика или покупки микроконтроллера без за-
грузчика разработчики предоставляют возможность прошить загрузчик в микро-
контроллер самостоятельно. Для этого в Arduino IDE встроена поддержка несколь-
ких популярных дешевых программаторов, а большинство плат Arduino имеет
штыревой разъем для внутрисхемного программирования (ICSP для AVR, JTAG
для ARM).

В Arduino IDE от компании, базирующейся на сайте arduino.cc, встроена
возможность создания своих программно-аппаратных платформ. Этой возможно-
стью пользуются сторонние компании, добавляющие в Arduino IDE свои наборы
плат и компиляторов-загрузчиков к ним. Компания на сайте arduino.org не под-
держивает такую возможность.

В линейке устройств Arduino в основном используются микроконтроллеры
Atmel AVR ATmega328, ATmega168, ATmega2560, ATmega32U4, ATTiny85 с часто-
той тактирования 16 или 8 МГц. В старых же изделиях применялись ATmega8,
ATmega1280 и другие. Так же, есть также платы на процессоре ARM Cortex M.

При создании устройства, регистрирующего вариации атмосферного элек-
трического поля, лучше всего использовать плату Arduino Nano с микроконтрол-
лером ATmega328, поскольку её проще изолировать от возможных осадков в кор-
пусе.

Если говорить о характеристиках платы, то рабочее напряжение состав-
ляет 5 В. Так же имеется 14 цифровых входов/выходов, 6 из которых могут ис-
пользоваться как входы широтно-импульсной модуляции (ШИМ). Помимо этого,
у Nano есть 8 аналоговых входов. Постоянный ток через вход/выход – 40 мА.
Флеш-память платы 32 кБ, при этом 2 кБ используются для загрузчика, о кото-
ром шла речь чуть выше. Оперативная память платы (ОЗУ) 12 кБ. Электрически
стираемое перепрограммируемое ПЗУ (EEPROM или ЭСППЗУ) 1 кб. Тактовая
частота 16 МГц. И наконец, размеры платы 1.85х4.2 см.

Arduino Nano может получать питание через подключение Mini-B USB, или
от нерегулируемого 6-20 В (вывод 30), или регулируемого 5 В (вывод 27), внеш-
него источника питания. Автоматически выбирается источник с самым высоким
напряжением.
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Микросхема FTDI FT232RL получает питание, только если сама платфор-
ма запитана от USB. Таким образом при работе от внешнего источника (не USB),
будет отсутствовать напряжение 3.3 В, генерируемое микросхемой FTDI, при этом
светодиоды RX и TX мигают только при наличии сигнала высокого уровня на вы-
водах «0» и «1».

Микроконтроллер ATmega328 имеет 32 кБ для хранения кода программы.
Так же ATmega328 – 2 кБ ОЗУ и 1 Кб EEPROM, которая читается и записывается
с помощью библиотеки EEPROM.

Каждый из 14 цифровых выводов Nano, используя функции pinMode(),
digitalWrite(), и digitalRead(), может настраиваться как вход или выход. Выводы
работают при напряжении в 5 В. Каждый вывод имеет нагрузочный резистор
(стандартно отключен) 20-50 кОм и может пропускать до 40 мА. Некоторые вы-
воды имеют особые функции:

последовательная шина: 0 (RX) и 1 (TX). Выводы используются для полу-
чения (RX) и передачи (TX) данных TTL. Данные выводы подключены к соот-
ветствующим выводам микросхемы последовательной шины FTDI USB-to-TTL;
внешнее прерывание: 2 и 3. Данные выводы могут быть сконфигурированы на вы-
зов прерывания либо на младшем значении, либо на переднем или заднем фронте,
или при изменении значения. Подробная информация находится в описании функ-
ции attachInterrupt();

ШИМ: 3, 5, 6, 9, 10, и 11. Любой из выводов обеспечивает широтно-импульс-
ную модуляцию с разрешением 8 бит при помощи функции analogWrite();

SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). Посредством данных выводов
осуществляется связь SPI, которая, хотя и поддерживается аппаратной частью,
не включена в язык Arduino;

LED: 13. Встроенный светодиод, подключенный к цифровому выводу 13.
Если значение на выводе имеет высокий потенциал, то светодиод горит.

Как уже упоминалось, на платформе Nano установлены 8 аналоговых вхо-
дов, с разрешением в10 бит каждый, то есть можно принимать 1024 различных
значения (от 0 до 1023). Несмотря на то, что выводы обычно имеют диапазон
измерения до 5 В относительно «земли», есть возможность изменить верхний пре-
дел используя функцию analogReference() до 1.1 В. Некоторые выводы имеют
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дополнительные функции. Так А4 (SDA) и А5 (SCL) предназначены для связи по
прототипу ISC (TWI) для работы с которыми используется библиотека Wire.

Дополнительная пара выводов платформы:
AREF. Опорное напряжение для аналоговых входов, которое используется

с функцией analogReference(). RESET. Низкий уровень сигнала на выводе переза-
гружает микроконтроллер. Применяется как правило для подключения кнопки
перезагрузки на плате расширения, закрывающей доступ к кнопке самой платы
Arduino Nano, или прошивки других плат, когда работа самого микроконтроллера
не нужна.

В Arduino Nano установлено небольшое количество устройств для осуществ-
ления связи другими устройствами Arduino или микроконтроллерами, а так же,
с компьютером. ATmega328 поддерживает последовательный интерфейс UART
TTL (5 В), с имеющимися каналами для вывода: 0 (RX) и 1 (TX). Микросхема
FTDI FT232RL, которая установлена на плате, направляет данный интерфейс
посредством USB, а драйверы FTDI , что включены в программу Arduino, предо-
ставляют из себя виртуальный COM порт программе на компьютере. Слежение за
сигналом последовательной шины (Serial Monitor) программы Arduino позволяет
нам как посылать, так и получать текстовые данные при подключении к плат-
форме. Светодиоды RX и TX на платформе мигают, когда происходит передача
данных через микросхему FTDI или USB подключение, однако не при использо-
вании последовательной передачи через выводы 0 и 1.

При помощи библиотеки SoftwareSerial можно осуществить последователь-
ную передачу данных через любой из цифровых выводов Arduino Nano.

ATmega328 поддерживает интерфейсы I2C и SPI. Так же в Arduino была
включена библиотека Wire, чтобы было удобнее использовать шины I2C.

Платформа программируется через использование програмного обеспече-
ния Arduino IDE. В меню « Tools > Board » находится « Arduino Diecimila,
Duemilanove или Nano w/ ATmega168 » или « Arduino Duemilanove или Nano
w/ ATmega328 », согласно используемому микроконтроллеру.

Микроконтроллеры ATmega168 и ATmega328 производятся с сразу запи-
санным загрузчиком, который значительно облегчает запись новых программ,
чтобы не использовать внешние программаторы. Связь осуществляется ориги-
нальным протоколом STK500.
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Так же, имеется возможность не использовать загрузчик и запрограмми-
ровать микроконтроллер через выводы блока ICSP, внутрисхемное программиро-
вание.

Стоит упомянуть, что Arduino Nano разработана таким образом, чтобы
перед записью нового кода перезагрузка осуществлялась самой программой, а не
нажатием кнопки на платформе. Одна из линий FT232RL, управляющих потоком
данных (DTR), подключена к выводу перезагрузки микроконтроллера ATmega328
через конденсатор 100 нФ. Активация данной линии, т.е. подача сигнала низкого
уровня, перезагружает микроконтроллер. Программа Arduino, используя данную
функцию, загружает код одним нажатием кнопки Upload в самой среде програм-
мирования. Подача сигнала низкого уровня по линии DTR скоординирована с
началом записи кода, что сокращает таймаут загрузчика.

Функция имеет еще одно применение. Перезагрузка Nano происходит каж-
дый раз при подключении к программе Arduino IDE на компьютере с ОС Mac X
или Linux (через USB). Следующие полсекунды после перезагрузки работает за-
грузчик. Во время программирования происходит задержка нескольких первых
байтов кода во избежание получения платформой некорректных данных (всех,
кроме кода новой программы). Если производится разовая отладка скетча, запи-
санного в платформу, или ввод каких-либо других данных при первом запуске,
необходимо убедиться, что программа на компьютере ожидает в течение секунды
перед передачей данных [15].

Контроллерный модуль Arduino Nano имеет небольшие размеры, что удоб-
но для установки в малогабаритные приборы, вроде флюксметра, но значительно
осложняет макетирование схем и отладку работы приборов. Плата расширения
для Arduino Nano разработана для облегчения подключения и позволяет испра-
вить этот недостаток, соединением одной платы с другой. Внешний вид платы
представлен на рисунке 3.3.

С помощью платы расширения облегчается подключение различных дат-
чиков и исполнительных устройств, так как помимо одного канала, имеется три:
сигнал, напряжение (5 В), «земля». На плате расположены кнопка сброса и инди-
катор включения питания. Технология изготовления обеспечивает работоспособ-
ность при токовой нагрузке вызываемой электродвигателями.

23



Рисунок 3.3 — Расширяющая плата, и подключенная к ней Arduino Nano

Модуль имеет круглый соединитель для подключения питания. Обеспечи-
вается подключение периферии к питанию 5 В и следующим сигналам Arduino
Nano:

14 цифровых входов-выходов с контактами питания;
8 аналоговых входов с контактами питания;
Интерфейсы UART и I2C c контактами питания;
Вход опорного напряжения АЦП [6].

3.2 WiFi модуль ESP 8266

Сторонние разработчики портировали в Arduino поддержку популярного
WiFi микроконтроллера ESP8266. Благодаря этому, стало возможно компилиро-
вать и загружать прошивку для ESP8266 со своими скетчами и поддержкой WiFi
можно прямо из Arduino ide, получая одноплатную схему с поддержкой сети Wi-
Fi.

ESP8266 это микроконтроллер, разработанный китайским производителем
Espressif с интерфейсом WiFi. Помимо WiFi микроконтроллер отличается воз-
можностью исполнять программы из внешней флеш-памяти с интерфейсом SPI.
Данный микроконтроллер привлёк к себе внимание в 2014 году в связи с выходом
первых продуктов на его базе и их необыкновенно низкой ценой.
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Процессор микроконтроллера Tensilica работает на частоте 80 МГц при
32 разрядахах. Wi-Fi может поддерживать WEP и WPA/WPA2. Питание от 3.0
до 3.6 В. Потребление тока до 200 мА, находясь в режиме передачи, и 60 мА,
в режиме приема. Режим пониженного потребления с сохранением соединения с
точкой доступа 1 мА [12].

Микроконтроллер не имеет на кристалле пользовательской энергонезависи-
мой памяти. Исполнение программы ведется из внешней SPI ПЗУ путём динами-
ческой подгрузки требуемых участков программы в кэш инструкций. Подгрузка
идет аппаратно, прозрачно для программиста. Поддерживается до 16 МБ внешней
памяти программ. Возможен Standard, Dual или Quad SPI интерфейс.

Производитель, к сожалению, не предоставляет полной документации на
внутреннюю периферию микроконтроллера. Вместо этого он дает набор библио-
тек, через API которых программист получает доступ к периферии. Поскольку
эти библиотеки интенсивно используют ОЗУ контроллера, то производитель в
документах не указывает точное количество ОЗУ на кристалле, а только при-
близительную оценку того количества ОЗУ, что останется пользователю после
компиляции библиотек — порядка 50 кБ. Энтузиасты, исследовавшие библиотеки
ESP8266, предполагают, что он содержит 32 кБ кэша инструкций и 80 кБ ОЗУ
данных.

Источник исполняемой программы ESP8266 задается состоянием портов
GPIO0, GPIO2 и GPIO15 (см. рисунок 3.4) в момент окончания сигнала Reset,
то есть подачи питания. Наиболее интересны два режима: исполнение кода из
UART (GPIO0 = 0, GPIO2 = 1 и GPIO15 = 0) и из внешней ПЗУ (GPIO0 = 1,
GPIO2 = 1 и GPIO15 = 0). Режим исполнения кода из UART используется для
перепрошивки подключенной флеш-памяти, а второй режим штатный рабочий.

Рисунок 3.4 — Схема Wifi модуля esp8266

Программные средства разработки (программный комплект разработчика,
SDK) состоят из:
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компилятора, который для Xtensa LX106 входит в пакет компиляторов
GNU Compiler Collection;

библиотек для работы с периферией контроллера, стеков протоколов WiFi,
TCP/IP;

средств загрузки исполняемого файла в память программ микроконтрол-
лера;

опциональной IDE.
Так же Espressif свободно распространяет свой комплект разработчика. В

этот комплект входит компилятор GCC, библиотеки Espressif и загрузочная ути-
лита XTCOM. Библиотеки поставляются в виде скомпилированных библиотек,
без исходных текстов. Espressif поддерживает две версии SDK: одна на основе
RTOS, другая на основе обратных вызовов (callback).

Чтобы упростить использование микроконтроллера в типовых проектах
возможно использование готовых бинарных файлов, пригодных к прямой заливке
в ПЗУ модулей (так называемых прошивок). Готовые прошивки можно разделить
на несколько групп согласно концепции их использования [11]:

прошивки для работы под управлением внешнего контроллера, как в слу-
чае с флюксметром. В этих прошивках реализован некий функционал, которому
внешний контроллер через UART задает параметры работы. К таким прошивкам
относится прошивка с управлением AT-командами из SDK Espressif. Там же мож-
но найти документы «4A-ESP8266AT Instruction Set» и «4B-ESP8266AT Command
Examples». На просторах интренета можно найти множесто описаний АТ команд
в том числе и на русском языке. Также есть утилита, позволяющая сконфигури-
ровать модуль без знания AT команд;

прошивки с встроенными интерпретаторами разнообразных языков высоко-
го уровня. Эти прошивки позволяют подгружать через UART и исполнять скрип-
ты разработчика устройства;

NodeMCU — проект на основе скриптового языка Lua. Прошивка умеет
исполнять Lua-скрипты как из UART (аналогично AT-командам) так и из внут-
ренней flash памяти. Для загрузки скриптов в flash память поддерживается фай-
ловая система. Со стороны Wi-Fi имеются встроенные MQTT протокол и HTTP
сервер. Встроена графическая оболочка, что позволяет подключать к ESP8266
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графические индикаторы. В интернет-магазинах популярны недорогие модули с
прошивкой NodeMCU;

Espruino — проект на основе скриптового языка JavaScript. Имеется гра-
фическая оболочка (IDE) для работы с исходными текстами скриптов и закачки
их в модули;

ESP8266 BASIC — проект на основе скриптового языка Basic. Проект отли-
чает возможность редактирования и запуска скриптов через браузер, через HTML
страничку ESP8266. Также проект поддерживает свою графическую утилиту для
прошивки флеш-памяти. Поддерживаются модули с 512 кБ, 1, 2 или 4 МБ памяти;

прошивки для «интернета вещей» (управление бытовыми приборами через
Wifi) – это такой класс прошивок, который позволяет с одной стороны подклю-
чить к ESP8266 набор датчиков и исполнительных устройств, а с другой стороны
предоставляет необходимый сетевой функционал для работы в инфраструктуре
Internet of Things;

ESP Easy — прошивка для домашней автоматизации. Выполнена как скетч
Arduino. Поддерживает множество датчиков и исполнительных устройств, под-
держка которых есть в Arduino (например, датчики температуры, влажности,
освещенности, дисплеи, реле и т. п.). Есть клиент MQTT;

WiFi-IoT.ru — онлайн конструктор IoT-прошивок для ESP8266 от Макси-
ма Миклина для проекта домашней автоматизаци. [8] Позволяет прямо на сайте
создать прошивку ESP8266 для работы с одной из множества поддерживаемых
IoT систем верхнего уровня. Вариант требуемой прошивки создается путём выбо-
ра опций конфигурации. Проект коммерческий, но есть бесплатные ограниченные
возможности;

прошивки для популярного применения переходника UART-WiFi;
проект библиотек HTTP сервера с файловой системой для ESP8266. Здесь

реализована настройка WiFi параметров через HTML интерфейс. На основе биб-
лиотеки создан проект TCP2UART переходника;

ESP8266-transparent-bridge — это проект прозрачного переходника TCP-
UART.

Разумеется, что для управления процессом обновления прошивки имеется
множество утилит, таких как:

XTCOM — консольная утилита из Espressif SDK;
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NodeMCU-Flasher — оконная утилита под Windows;
esptoolck — консольная утилита, написанная на Си;
esptool — консольная утилита, написанная на C++;
esptool.py — консольная утилита, написанная на Python.
Внешняя SPI flash должна иметь определенный заголовок для коррект-

ного исполнения кода. Структура заголовка указана в документации к утилите
XTCOM. Загрузочные утилиты обычно умеют добавлять его к прошивке.

Создатели микроконтроллера предусмотрели возможность обновить про-
шивку работающего устройства через WiFi. Для этого разделяют флеш-память
программ на несколько частей. Одна отводится менеджеру прошивок, две другие
под пользовательскую программу. Когда хотят обновить прошивку, новый образ
загружают в свободную часть флеш-памяти. После тщательной проверки целост-
ности вновь загруженного образа менеджер прошивок переключает флажок, по-
сле чего участок памяти со старой прошивкой освобождается, а исполнение кода
идет из нового участка. Соответственно в следующий раз обновление будет загру-
жаться в свободный участок памяти.

ESP8266 может работать как в роли точки доступа так и оконечной стан-
ции. При нормальной работе в локальной сети ESP8266 конфигурируется в режим
оконечной станции. Для этого устройству необходимо задать SSID WiFi сети и, в
закрытых сетях, пароль доступа. Для первоначального конфигурирования этих
параметров удобен режим точки доступа. В режиме точки доступа устройство
видно при стандартном поиске сетей в планшетах и компьютерах. Остается под-
ключиться к устройству, открыть HTML страничку конфигурирования и задать
сетевые параметры. После чего устройство штатно подключится к локальной сети
в режиме станции.

В случае исключительно локального использования возможно всегда остав-
лять устройство в режиме точки доступа, что снижает необходимые усилия поль-
зователя по его настройке.

После подключения к WiFi сети устройство должно получить IP-парамет-
ры локальной сети. Эти параметры можно задать вручную вместе с параметрами
WiFi или же активизировать какие либо сервисы автоматического конфигуриро-
вания IP-параметров.
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После настройки IP параметров обращение к серверу устройства в локаль-
ной сети обычно осуществляется по его IP адресу, сетевому имени (в случае если
имена поддержаны какой либо технологией) или сервису (в случае если поддер-
жан автоматический поиск сервисов).

Зачастую доступ к устройству требуется из Интернета. Например пользова-
тель с мобильного телефона удаленно проверяет состояние своего «умного дома»,
обращаясь напрямую к устройству. В этом случае устройство работает в режиме
сервера, к которому обращается внешний клиент.

3.3 Интегрированная среда разработки Arduino IDE

Среда разработки Arduino состоит из встроенного текстового редактора
программного кода, области сообщений, окна вывода текста (консоли), панели ин-
струментов с кнопками часто используемых команд и нескольких меню. Всё это
можно посмотреть на рисунке 3.5. Для загрузки программ и связи среда разра-
ботки подключается к аппаратной части Arduino.

Программа, написанная в среде Arduino IDE, называется скетчем. Скетч
пишется в текстовом редакторе, имеющем инструменты вырезки/вставки, поис-
ка/замены текста. Во время сохранения и экспорта проекта в области сообщений
появляются пояснения, также могут отображаться возникшие ошибки. Окно вы-
вода текста показывает сообщения Arduino IDE, включающие полные отчеты об
ошибках и другую информацию, например размера скетча. Кнопки панели ин-
струментов позволяют проверить и записать программу, создать, открыть и со-
хранить скетч, открыть мониторинг последовательной шины: Verify/Compile (про-
верка программного кода на ошибки, компиляция), Stop (остановка мониторинга
последовательной шины (Serial monitor) или затемнение других кнопок), New (со-
здание нового скетча), Open (открытие меню доступа ко всем скетчам в блокноте,
открывается нажатием в текущем окне), Save (сохранение скетча), Upload to I/O
Board (компилирует программный код и загружает его в устройство Arduino),
Serial Monitor (открытие мониторинга последовательной шины).

Дополнительные команды сгруппированы в пять меню: File, Edit, Sketch,
Tools, Help. Доступность меню определяется работой, выполняемой в данный мо-
мент.
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Рисунок 3.5 — Внешний вид Arduino IDE 1.6.7

Copy for Discourse копирует в буфер обмена подходящий для размещения
на форуме код скетча с выделением синтаксиса;

Copy as HTML копирует код скетча в буфер обмена как HTML код, для
размещения на веб-страницах;

Verify/Compile проверка скетча на ошибки;
Import Library добавляет библиотеку в текущий скетч, вставляя дирек-

тиву include в код скетча. Подробная информация в описании библиотек ниже
(Libraries);

Show Sketch Folder открывает папку, содержащую файл скетча, на рабочем
столе;
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Add File добавляет файл в скетч (файл будет скопирован из текущего места
расположения). Новый файл появляется в новой закладке в окне скетча. Файл
может быть удален из скетча при помощи меню закладок;

Auto Format оптимизирует код, например, выстраивает в одну линию по
вертикали открывающую и закрывающую скобки и помещает между ними утвер-
ждение;

Board выбор используемой платформы. Список с описанием платформ при-
водится ниже;

Serial Port меню содержит список последовательных устройств передачи
данных (реальных и виртуальных) на компьютере. Список обновляется автома-
тически каждый раз при открытии меню Tools;

Burn Bootloader данное меню позволяет записать Загрузчик (Bootloader) в
микроконтроллер на платформе Arduino. Данное действие не требуется в текущей
работе с Arduino, но пригодится, если имеется новый ATmega (без загрузчика). Пе-
ред записью рекомендуется проверить правильность выбора платформы из меню.
При использовании AVR ISP необходимо выбрать соответствующий программа-
тору порт из меню Serial Port.

Средой Arduino IDE используется принцип блокнота: стандартное место
для хранения программ. Скетчи из блокнота открываются через меню «File >
Sketchbook» или кнопкой «Open» на панели инструментов. При первом запуске
программы Arduino автоматически создается директория для блокнота. Располо-
жение блокнота меняется через диалоговое окно «Preferences».

Закладки, «Файлы» и «Компиляция» позволяют работать с несколькими
файлами скетчей, каждый из которых открывается в отдельной закладке. Фай-
лы кода могут быть стандартными Arduino (*.ino), файлами С (расширение *.с),
файлами С++ (*.срр) или заголовными файлами (.h).

Перед загрузкой скетча требуется задать необходимые параметры в меню
«Tools > Board» и «Tools > Serial Port». Платформы описываются далее по тексту.
В ОС Mac последовательный порт может обозначаться как dev/tty.usbserial-1B1
(для платы USB) или /dev/tty.USA19QW1b1P1.1 (для платы последовательной
шины, подключенной через адаптер Keyspan USB-to-Serial). В ОС Windows пор-
ты могут обозначаться как COM1 или COM2 (для платы последовательной шины)
или COM4, COM5, COM7 и выше (для платы USB). Определение порта USB про-
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изводится в поле «последовательной шины» USB Диспетчера устройств Windows.
В ОС Linux порты могут обозначаться как /dev/ttyUSB0, /dev/ttyUSB1.

После выбора порта и платформы необходимо нажать кнопку загрузки на
панели инструментов или выбрать пункт меню «File > Upload to I/O Board». Со-
временные платформы Arduino перезагружаются автоматически перед загрузкой.
На старых платформах необходимо нажать кнопку перезагрузки. На большинстве
плат во время процесса будут мигать светодиоды RX и TX. Среда разработки
Arduino IDE выведет сообщение об окончании загрузки или об ошибках.

При загрузке скетча используется загрузчик Arduino, небольшая програм-
ма, загружаемая в микроконтроллер на плате. Она позволяет загружать про-
граммный код без использования дополнительных аппаратных средств. Загруз-
чик активен в течении нескольких секунд при перезагрузке платформы и при
загрузке любого из скетчей в микроконтроллер. Работа загрузчика распознается
по миганию светодиода (13 контакт), например, при перезагрузке платы.

Библиотеки добавляют дополнительную функциональность скетчам, на-
пример, при работе с аппаратной частью или при обработке данных. Для ис-
пользования библиотеки необходимо выбрать меню «Sketch > Import Library».
Одна или несколько директив include будут размещены в начале кода скетча с
последующей компиляцией библиотек и вместе со скетчем. Загрузка библиотек
требует дополнительного места в памяти Arduino. Неиспользуемые библиотеки
можно удалить из скетча убрав директиву include.

На Arduino.cc имеется список библиотек. Некоторые библиотеки включены
в среду разработки Arduino. Другие могут быть загружены с различных ресур-
сов. Для установки скачанных библиотек необходимо создать каталог «libraries» в
каталоге установки Arduino IDE и затем распаковать архив. Например, для уста-
новки библиотеки DateTime ее файлы должны находится в подкаталоге /libraries
/DateTime.

Поддерживаемые аппаратные средства других производителей добавляют-
ся в соответствующий подкаталог. Устанавливаемые платформы могут включать
собственные характеристики (в меню платформы), корневые библиотеки, загруз-
чик и характеристики программатора. Для установки требуется распаковать ар-
хив в созданный каталог. Запрещено использовать наименование папки "arduino т.к.
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могут быть перезаписаны встроенные данные платформы Arduino. Для деинстал-
ляции данных удаляется соответствующий каталог.

Мониторинг последовательной шины (Serial Monitor) отображает данные
посылаемые в платформу Arduino (плата USB или плата последовательной ши-
ны). Для отправки данных необходимо ввести текст и нажать кнопку «Send» или
клавишу «Enter». Затем выбирается скорость передачи из выпадающего списка,
соответствующая значению Serial.begin в скетче. На ОС Mac или Linux платфор-
ма Arduino будет перезагружена (скетч начнется сначала) при подключении мо-
ниторинга последовательной шины. Имеется возможность обмена информацией с
платформой через программы Processing, Flash, MaxMSP и т.д.

Некоторые настройки изменяются в окне «Preferences» (меню Arduino в
ОС Mac или «File» в ОС Windows и Linux). Остальные настройки находятся в
файле, месторасположение которого указано в окне «Preferences» [7].

3.4 Конструкция флюксметра

Как уже писалось выше, конструкция флюксметра (см. рисунок 2.1) до-
вольно-таки простая. На рисунках 3.6 и 3.7 представлены фотографии моего
устройства. Можно убедиться, что создание флюксметра возможно из подручных
средств.

Рисунок 3.6 — Реализация метода Вильсона
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Рисунок 3.7 — Реализация метода Вильсона при помощи Arduino Nano

В качестве корпуса, выбрана токопроводящая банка, выполняющая роль
экрана. В крышке банки сделаны прорези для осуществления модуляции, а для на-
копления заряда, на внутренней поверхности нанесён слой фольги. Так же, слой
проводящего металла был нанесён на поверхности регистрирующей пластины.
Пластина закреплена на корпусе прибора изолирующим мателиалом. В качестве
роторного двигателя, используется кулер, питающийся от 5В с восьмого цифро-
вого канала (см рисунок 3.8). Arduino Nano, и её расширяющая плата размещены
вне прибора, для предотвращения помех из-за работы микроконтроллера, а так
же, для свободной работы WiFi модуля ESP8266.

3.5 Калибровка флюксметра

Для исправной работы устройства необходимо провести его калибровку.
В нашем случае необходимо знать значения напряжённости поля в воздухе, в
котором будет происходить замер значений. При помощи генератора, и двух ме-
таллических проводящих сеток, можно задавать определённое напряжение. При
этом, расстояние между сетками 4,5 см, а задаваемое напряжение 0-60 В. Шаг
был выбран в 10 В. Результаты измерений представлены в приложении А.

В качестве вывода, можно сказать, что выбор микроконтроллера Arduino
Nano позволит создать рабочее устройство, для регистрации вариаций напряжён-
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Рисунок 3.8 — Схема реализованного флюксметра

ности атмосферного электрического поля, поскольку его работа определяется точ-
ностью выполнения, доступностью (в ценовом плане), удобством использования
и программирования.
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4 Анализ результатов измерений напряжённости электриче-

ского поля

4.1 Описание условий проведения полевых измерений

Для того чтобы пластины заряжались, принимая заряд из атмосферы,
устройство необходимо расположить на высоте, поскольку, оставив у поверхно-
сти земли, заряд будет не откуда принимать, и сигнал будет нулевым. Мною бы-
ли сняты показания на высоте 2м, что является достаточным, для регистрации
напряжённости поля. Так же, измерения проводились в дали от электроприбо-
ров, будь то трансформаторная будка, фонарный столб, линии электропередач.
Фклюксметр включался в пасмурную и ясную погоду, для выявления различий
между состояниями поля атмосферы.

4.2 Результаты измерений уровня собственных шумов

Как уже упоминалось выше, измерения у поверхности земли никакого сиг-
нала нам не дадут. А это значит, можно будет зарегистрировать шум, произво-
димый микроконтроллером. На рисунке 4.1 изображён сигнал, принятый устрой-
ством, у поверхности земли. Видно, что сигнал не так велик, как при измерениях
на высоте 2 м, и в среднем составляет 3 единицы АЦП, то есть 6 В/м.

Рисунок 4.1 — Сигнал, регистрируемый флюксметром у поверхности Земли

Для исключения вероятного заряда, который мог бы приходить из окру-
жающего воздуха, прибор был экранирован фольгой. Сигнал, измеряемый при
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таких условиях, изображён на рисунке 4.2. Необходимо этот шум учитывать, и
делать приборную поправку, при измерениях напряжённости электрического по-
ля. Средний уровень шумов составляет 1 В/м.

Рисунок 4.2 — Собственный шум флюксметра

4.3 Анализ данных о влиянии облачности на значение напряжённости
электрического поля

На рисунках 4.3 и 4.4 представлены принятые сигналы при ясной и пас-
мурной погоде. Видно, что разница в сигналах значительная: 2500-3500 В/м при
пасмурном небе, и 100-450 В/м при ясном, что соответствует нормальному состо-
янию поля данных этих условиях.

Исходя из результатов измерений, можно заключить, что методом Виль-
сона можно регистрировать напряжённость электрического поля атмосферы, ис-
пользуя микроконтроллер Arduino Nano.

Так же, в ходе измерений было определено время релаксации флюксметра
(рисунок 4.5). Видно, что период «стекания» сигнала (время разрядки корпуса
устройства) составило порядка 10000 принятых значений, что равно 8.2 секунды.

При дальнейшем анализе, принимаемый сигнал был преобразован мето-
дом Фурье, для определения частоты принимаемого сигнала. Результаты проил-
люстрированы на рисунках 4.6 и 4.7, на которых видно, что частота полезного
сигнала приходится на 10 Гц (частота модуляции нижней пластины), в отличие
от 50 Гц в случае влияния электроприборов.
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Рисунок 4.3 — Измеренный сигнал при пасмурной погоде

Рисунок 4.4 — Спектр сигнала, измеренного при ясной погоде
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Рисунок 4.5 — Спектр сигнала, измеренного при облачной погоде

Рисунок 4.6 — Преобразованый сигнал измеренный при ясной погоде
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Рисунок 4.7 — Преобразованый сигнал измеренный в поле действия
окружающих электроприборов
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Заключение

При выполнении работы, проведённой в рамках выпускной квалификаци-
онной работы, все поставленные задачи были выполнены:

- выявлена корреляция между значениями ГКЛ и напряжённости электри-
ческого поля атмосферы, и найдена связь этих параметров;

- проанализированы значения потенциала солнечной модуляции в паре с
напряжённостью атмосферного поля, и так же найдена их связь;

- разработана конструкция устройства для регистрации вариаций напря-
жённости электрического поля;

- создан флюксметр для измерения напряжённости атмосферного электри-
ческого поля на базе Arduino Nano, основанный на методе Вильсона;

- проведена серия измерений в натурных условиях, и осуществлена обработ-
ка полученных данных и выполнена предварительная калибровка измерительной
системы.

Таким образом, в результате было получено относительно недорогое устрой-
ство, которое способно измерять значение напряжённости электрического поля,
и осуществлять передачу данных по беспроводному каналу связи WiFi на сер-
вер хранения баз данных, доступных через Интернет. Дальнейшие исследования
должны быть направленый на создание/разработку итогового варианта флюкс-
метра, учитывающего влияние всех факторов, например такого как уровень иони-
зации воздуха.
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Приложение А

Результаты измерений флюксемром в лабораторных условиях

Рисунок А.1 — Сигнал измеренный в поле, с напряжением в 0 В

Рисунок А.2 — Сигнал измеренный в поле, с напряжением в 10 В
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Рисунок А.3 — Сигнал измеренный в поле, с напряжением в 20 В

Рисунок А.4 — Сигнал измеренный в поле, с напряжением в 30 В

Рисунок А.5 — Сигнал измеренный в поле, с напряжением в 40 В
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Рисунок А.6 — Сигнал измеренный в поле, с напряжением в 50 В

Рисунок А.7 — Сигнал измеренный в поле, с напряжением в 60 В
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